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I want to thank you for your purchase of the Best Rotary you will Ever Purchase!
My goal has been and always will be to supply you with the very best product that | can
and customer service that is second to none. | have carefully thought of every possible

way to make this the very last Rotary you will Ever need, but of course that is just one
person’s perspective on this. If you have any suggestions to make it better please let me
know and | will take every possible measure to implement any needed changes and in
most cases at no expense to you.

The complete line of Rotoboss Rotary Attachments carry a

LIFETIME WARRANTY!

From the date of purchase.

Warranty covers any mechanical defect, failure of the rotary, and /or its components at
no charge to you. Motors carry a one year only Warranty. If you have received this product
and it is damaged please take pictures of everything and send them to us so we can file a

claim with the carrier. | will get replacement parts sent out right away!

=
[@ -I Please leave a review and feedback, good or bad on any of the Rotoboss pages!

Click any link below to connect to our pages directly, if you get
a “security warning” just make sure to click allow.
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**See @lDEO GLOSSARY)for full web address, if button/links do not work for some reason.**
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WHAT IS A ROTARY? t
© IAHY DO YOU NEED ONE? Bamie

Laser rotaries come in two main types, the four-wheel rotary roller and the rotary chuck. Both allow the user to
engrave around cylindrical objects, which would otherwise be impossible with a laser alone.

The chuck tools have been in the woodworking and metal lathe industries for a long time and in the laser
world for about 15-20 years. However, in the last couple of years, laser rotary companies have been working to
improve the rotary chuck specifically for laser use.

The roller tools have been in the laser community for about 10-15 years, only recently improved upon by
several laser rotary companies and hobbyists. The improvements have made working with round objects easier
and more efficient than ever, leading to a huge boom in the customized drinkware market.

Each type has its place, but with the advancement of some rotary rollers currently on the market, the rotary
chuck has become less and less useful for common, everyday items. So when it comes right down to it, which
one you need depends on how you intend to use it.

A quality roller rotary with features such as clamps, heel plate, and lifting systems is designed and built
for the commercial production user that processes small to large quantities of the same or multiple objects.
They genuinely give you dependable repeatability with the least amount of wasted materials. (Waste can be due
to objects moving or slipping which ruins your piece and costs your business money.) The rollers are also useful
for hobbyists, small production outfits, or one-off custom shops due to their ease of use and dependability - no
matter the size of your business or hobby, time is money!

Chuck rotaries are the oldest type, and until recently, they were the most commonly used - sometimes
the only option for doing cylindrical objects. Typical chucks are often heavy, cumbersome rotary tools that can
be hard to operate. In addition, they can often damage the items you are working on because of how they hold
your item and the pressure needed to keep it securely in place. People over the years have made some great
adaptations to the common chuck rotary to make it more useful. In addition, companies started developing
their own versions of the rotary chuck, geared specifically towards the laser community. These new chuck-style
rotaries help address many of the problems previously encountered. Still, a persistent problem they can not
address is the inability to handle a production-type environment. The nature of how they work increases the
setup and production time compared to a roller rotary, and again, time is money! With that being said, they do
have a place when working with very large and irregular items, such as glasses with a square base that can not
roll. Another use, for example, is a large dog bowl that, when placed on a roller rotary (depending on your laser),
may be too tall to fit within the confines of your laser.

Today the most popular and sought-after type of rotary on the market is the rotary roller. The choice is
yours as to which one you want or need to own.

As for why you would need any one of them at all, they are rolling ATM machines in the ever-growing
laser personalization market. With the fast-increasing demand for personalized drinkware, it is hard to
own a laser and not have some rotary tool to accommodate your customers’ needs. A rotary is an amazing
revenue generator and requires very little effort to make a good profit, and because of this, the ROI (return on
investment) is often realized within a few months of use.

Please take what you have read as a stepping stone and use this information to help dig a little deeper to
find what works for you and your business. You can not go wrong with either or both types in your toolbox. Having
all available tools at your disposal makes your business more versatile, allowing you to tackle any challenge that
walks through your door. The goal of this article was to help shed some light on different types of rotaries that
are out there, as well as briefly explore the uses and pros and cons of each. Hopefully, | met that goal! | wish you
the very best in your laser journey and hope it is hugely prosperous! If you have any questions about anything
covered in this article, please feel free to reach out to me.
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GHOOSE

WELL, HERE'S WHY!

RotoBoss Rotary Attachments are my creations out of necessity. | was
tired of the same old rotary on the market, and for the past several years
| have been making parts to improve the existing China rotary supplied by
many laser manufacturers. After making parts, | decided to make my very

own Rotary that addresses all the issues | have seen and dealt with. These
Rotaries are unlike any on the market today and hands down the last and
only Rotary you will ever need.

If you see anything similar to my rotaries under a different name, they
are clones or copies of the one and only!

| have made this Rotary universal for use on many different machines
running Light Burn and RUIDA controllers with stepper and servo motors.
This means there is a rotary for every machine!

At RotoBoss, we’re not just crafting rotary attachments; we’re redefining the future
of engraving. Blending traditional craftsmanship with groundbreaking innovations,
our laser rotary attachments stand unparalleled in design, versatility, and precision.
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All of the RotoBoss Rotary Attachments will currently work with
ANY laser using a Ruida or Trocen Stepper motor controller.
Utilizing any NEMA 17 or NEMA 23 Motors, by just simply
swapping out motors with no modifications needed, because the
mount has mounting holes for both types of motors.

Your rotary comes equipped with a top of the line 2 or 3 Phase
stepper motor in the form of a NEMA 17, 23 or Integrated stepper
motor that properly suits your application. Your Rotary will come
pre wired for use on your machine as needed. This means the
rotary is Plug and Play with your machine.



SYSTEM CHECKS:t:
PRIOR TO USE!

*Check and make sure that your machine was received in good
condition! Look for any broken, bent or busted pieces and parts.

*Ensure there are no loose or missing bolts, screws etc.

*Check Tensioner pulley block bolt for tightness to make sure it
didn’t loosen after initial setup and shipping (most common issue)




ROTARY PLACEMENT t
IN YOUR LASER: Foana®

NOTE: Since these rotaries work in a wide range of lasers the placement in your
laser may vary based on the Laser and Rotary combination you have. Below are
recommendations and common practices for placement of the rotaries in machines
unless expressly written below.

**%* Remove the Honeycomb bed and blades if installed “as needed” to fit
the rotary into the laser machine. Place your rotary into the machine firmly
on the Honeycomb bed, (if clearance permits) bottom of the machine, on
the crossbars in the bottom of the bed with the motor on the right side
looking into the machine. This placement is key to the proper rotation and
orientation as it is how the rotary was designed.

The best way to line up your rotary (in most cases) is to draw a line down the middle of
a cup and move the red dot over one side and then shift it to the other. You will adjust
the rotary placement until it is straight. The center of the motor side of the rotary can
be found by placing the red dot over the clamp arm and centered. You may also line it
up with the X axis gantry by sighting down the bar to line up the rotary cross bar.



SETUP et

Note: These settings are based on testing of said machines and are only baseline
numbers that may need to be tweaked for your machine/setup.
00 0000000000000 OOODODODOIOOOOOOOOONOONONEOOO

Controller settings for Lasers:
Settings below are BASELINE for The Talon Pro

Object Diameter is set based on the item you have in the rotary.
THUNDER
Steps Per Rotation: 16,400
HAOTIAN/GALYO
Steps Per Rotation: 25,600
ALL OTHER GANTRY
Steps Per Rotation: 20,000-26,000

When doing your set up, make sure you have an accurate diameter for the object you are doing.
(The diameter measurement is from the top of the object)
Example: 300z is 101mm and a 200z is 88mm.
00 000000000000 0000OCDOCDEOGDNOGOOGNOGNOGONONOGNOONOGONOOOOONO

EXAMPLES ONLY.
Note: The items used here are just to reference to how to accurately measure your items.

MACHINE R SOFTWARE #§%

Take note that the opening of the waterbottle is
smaller than the actual circumference.

In circumstances like these, be sure to measure
from the bottom to get an accurate diameter.

If not, your design will come out stretched or
squished. This is especially important if you plan to
do a full wrap on any type of bottle.

300z Water Bottle



SETUP EXAMPLES it:

EXAMPLES ONLY.
Note: The items used here are just to reference to how to accurately measure your items.

When doing the top part of the cup,
you want to measure the opening.

You can use the measuring tape
that is provided with each rotary, or
any ruler or tool you have to get an
accurate measurement.

SN\ 19ARIL ZOOY

When doing the bottom part of the
cup, you want to measure the bottom.

Don't forget to make sure the laser in
focus if doing the bottom area, as it is
lower in height than the top of the cup.




SOFTWARE SETUP t
PRIOR TO RUNNING YOUR MACHINE

- Once this setup is complete you should be able to do everything from small mugs
to 300z cups with little to no adjustments required of the Steps per Rev. outside that
steps should be used to make corrections based on the type of object you are using.
- With a 200z tumbler (preferably for best results) Complete the setup as follows:

- Create a 25.4 x 25.4 mm or 1lin x 1in box and fine tune setting from there. If the
image is stretched lower your Steps per rev and vice versa for too small.

“Do Not” Change the object diameter, it should be at 88mm and left alone (setup
was designed with these numbers although not applicable now). The only changes
should be made to the Steps per rotation as needed for your given object.

“Do Not” Use absolute coordinates when using the rotary or you will get an error.
You should use either “User Origin” or “Current Position” when using the Rotary and
always hti origin on the Laser control panel once you position the Rotary and head to
insure proper operation.

- If you choose to do the 360 deg test in lightburn it will alter the true 1 to 1 scale
that the above instruction set you up with and should be two separate setting files
for when doing engraving based on your project ( standard logo or wraps )

When trying to enable the rotary button for Y axis driven machines, for the main
screen follow previous instructions and search for beginner mode(circled below) and
make sure it is disabled as well.

Note: if using Thunder Gantry lasers, using test button does not work properly.

Desplay [ Graphics From RDWorks take your image and rotate it
OW Beginner Mode (Smpler Interface) 90 Deg. (top of image should face left)
B0 Enable Antislasing (siower, but pretty)
0 Filed Rendering {slower) From LightBurn take your image and rotate 270 Deg.

Frfbimer et For Boss, Full Spectrum, Thunder, Xtool, K-40 (top of
O Lise Dark Rackground

80 Show Palette Butten Labels image should face left) or
&0 Ignore cut-of-bounds chapes if possible 90 Deg. for AEON and some Laguna
(top of image should face Right)

@ Click here for Set up Videos

**See QIDEO GLOSSARY )for full web address, if button/links do not work for some reason.**

9

loobar lcon Size ) Noemal



https://www.youtube.com/playlist?list=PLYkJ_L4UZaCz5Dles-j1VAoMUpKNBuBK6
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LIGHTBUAN 3ETYP 3%

Using Lightburn, setup your settings as follows:

Rotary Manufacturer recommends only using Machine setting to make changes to rotary setup.
From the main screen, click on the Edit tab and scroll down to the Machine settings tab (make
sure the laser is on and connected to your PC) Scroll down to the Rotary parameters and fill in
as shown below. In the rotary settings make the change as required to the “Rotary Diameter”
and “Steps per Rotation” Your numbers will differ based on the machine. You can also use this
screen to turn rotary on and off or with the button shown below on the main screen of Lightburn.
| have found that If you use the rotary setup screen it will not function properly and the extra info
they can ask for that is not applicable to Roller rotaries.

(EXAMPLE IMAGES ONLY)

W
Enable Rotary .:] True
Pulses per rotation 3, 700.000
Chameter 36.000

For Lightburn, if you do not have The

Rotary enable switch on your main

screen, do the following;:

Go to the Edit tab.

Scroll down to Settings.

' == Look for the tab that says “show
far Home Nz G0 to Origin rotary enable” and click it green. Hit

(@ Enable Rotary ok and it will exit to the main screen,

you should now have the enable
rotary button under the laser tab on
the right.

E] Frame {_} Frame

(B Cut Selected Graphics

B Use Selection Crigin
s See photos for references on what
@) Optimize Cut Path your own software should look like.

10



EXAMPLES ONLY “\:

If the numbers provided do not work check your
Eﬂﬁﬁ ot Y Axis controller to see what the Pulse/Revs are for
Microstep Drive RS2 the given DIP Switch positions. (see photo)

e These charts give you a good baseline to work from,

but with so many different gear ratios it is hard to

ga say if these are 100% accurate. The trend indicates
o for my rotary, your Pulse/Rev is about 1.5 times the

number on the chart.

(example: 4000 on chart is 6000 in software settings)

Again, every machine can vary and these are

ONLY suggested settings based on testing and may

need fine tuning.

BN =

Currard Gehia[Paaa=AME - " 4

LL R E B B

Thunder laser motors ONLY:
On, Off, On, Off, On, Off

Yorahome 40W DIODE Laser Setup

Visual representation ONLY.
This is not a technical
description for your
specific rotary.

If you have trouble with your
settings please feel free to
contact me and | will assist as
needed. If you get your numbers
dialed in, | ask that you share
those settings with me so | can
update this manual to aid others
with their similar machines.
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IALON PRO %=

ONe OF a KiND...
WiTH UNIQUE FeaTUResS!

| First ever Laser 4 Jaw chuck that gives you more pressure with less force by disbursing
the pressure evenly and symmetrically. Ideal for more delicate and heavier items.

| Push button shaft lock allowing you easy one handed operations

v Keyed motor mount to ensure a proper no slip fitment on the motor shaft with pinch bolt.
This ensures no more need for worrying about grub screw backing out causing slop in the shaft
like other chuck rotaries.

v The most adjustable jaws on the market that allows for seamless transition between
smaller and larger cups without having to move or change any parts like other rotaries. These
jaws have a total of 1.75in adjustability from fully closed to fully open.

v Extension Bars that let you quickly extend your jaw size for doing all kinds of things like
dog bowls and more.

v Provisions made to mount the holding fixture on either side of the rotary depending on
how you mount it.

- Adaptable to the Rotoboss, Junior, Ascend and Galvo rotaries.

| Head can be positioned in a vertical position to mount a turntable to so you can use it to
do repeat objects in a rotating jig.

i Can be used with NEMA 17 or 23 Motors with no mods required.

12



TALON ACCESSORIES £t:

The Rotary no matter the configuration
you choose will come with:
Motor
Main motor mount

4 Jaws
Accessories Include:
»>Arm Extensions
»Thumbscrews per your Talon
»>Short, Medium and Long Grips
(Long Grips can be used to do smaller things like

Rings. Just make sure to unscrew the top, and pull
Medium Grips off the rubber pieces.)

F

Y Short Grips Long Grips



L

TALON SUPPORT it

*-
el d® ™

If you're looking for a little extra support, just to be on the safe side, look no further!
This is our Talon Support Attachment.
Depending on the Talon you have, this comes with an extrustion, and the arm tower. It is super
easy to install and provides additional security for your needs.

14



TALON ADD OHS  £t:

Depending on your Laser and configurations, we have a few different
options that can be purchased to upgrade your Talon.

These additional accessories include:
»Horizontal Arm Extensions
»Galvo Mount
»>Height Extension

Galvo Mount

(When a Galvo Talon is purchased,
this accessory comes with your
order and does not need to be
purchased separately.)

-

Height Extension

oo

Horizontal Arm Extensions

15
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History of Rotoboss it
Hello Everyone/

| wanted to take a moment to first thank you all for your continued
support. | realized three and a half years into the rotary business and
have not really discussed how we got to this point so | figured | would

take this opportunity to share that with you.
~9ason ”/Qzﬁ

It all started in 2018 after using lasers for a few years and utilizing the old standard China
rotary that typically came with every laser at the time. You know the one, the three-jaw chuck
rotary that has been around in the manufacturing industry for decades. | knew there had to be
a better way to get the job done more reliably so | created my own personal rotary to combat all
the deficiencies with what was on the current market. After having built my personal rotary, the
clamp system | had for it worked so well that | started making an adapted version for the China
rotaries to make them more dependable. After making the kits for old rotaries for some time, |
began to get asked if | was going to make a rotary for other makers.

At first, | was skeptical because it was a big gamble and a huge leap of faith but, there
was obviously a need out there if people were asking. After some thought | decided to take my
current rotary (unnamed) and see if | could refine it into a product that would be good for others
to use. After getting to a point where | thought | had something viable, | started to ask people if
they would be interested in a rotary that | was developing. To my surprise | had a lot of positive
feedback, so | decided to make a go of it.

Once | had the now Rotoboss made, | held a contest to help name it. There were some
great names submitted but, in the end, the eventual winner was “Rotoboss”. The original
Rotoboss was bootstrapped and launched on 1 Nov, 2019. Shortly after, the Junior and Low
Roller came into play as a more economical alternative to the Rotoboss. With the success of
the Rotoboss rotaries, | filed Design and Utility Patents in early 2020 to cover the design and
function of the Rotoboss Rotaries.

From 2019 to mid 2020 the rotaries were made of acrylic and 3D printed parts. As our
company grew, | reinvested all the money into the company to upgrade materials to refine the
product. In June of 2020 our first upgrade was the acrylic plates were replaced with metal plates
as well as the motor and slave wheel assemblies were improved upon. After great success with
these improvements, | was able to finally get the Rotaries to the point of All Metal 6061 Billet
Aluminum parts on 1 Oct, 2021. In 2022 we were able to do one better with Milled edges to
what they currently are today.



History of Rotocboss ,t

'ﬂ‘l d.t-

After 3 years of the “original” tried and true design, along with ample feedback from you
all about what you would like to see better, a change was made resulting in the current 2.0
rotaries being released in October 2022. The 2.0 rotaries kept true to the design and function of
the first gen rotaries with some added features:

* More adjustability in the height adjustments

* Quick adjustments on slave wheels

* Cosmetic changes to the look of the rotary and the ability to remove the
slave wheel lead screw

* Friction lock for quick adjustments and placement.

After quickly gaining traction with our rotaries, | was able to start working with 4 major
laser brands as early as 2019. Thunder Laser USA was our first and number one partnership
that is still going strong today in the USA and four other countries. Second was AEON laser USA
which we still supplied in the USA and two other countries. Third is AP Lazer. We worked with AP
Laser for about a year until they came out with their own rotary. Fourth would be Laguna Laser
which is still going strong for a little over a year now. Finally, we are working with a couple other
laser brands that will be announced in the near future.

All roads have led to 2023, where we now have our latest design to be released in April/
May 2023. The latest design is the “Rotoboss Ascend” which is a towerless scissor lift rotary
that once again will change the game for laser rotaries with its many one-off features such as
spring loaded heel wheel, improved clamping system, unobstructed pass-through capabilities for
long or odd shaped objects that would otherwise be unable to be done with other rotaries and
the free motion slave wheel slider.

Once again, we have decided to expand our line of rotaries and invest in something that
has been in the back of my mind for a couple of years now. With the recent interest of galvo
lasers and usage of the standard China chuck rotaries, there is interest from the maker market
to bring to them a chuck style rotary that is modernized. Our design team is now working on
the “Rotoboss Talon” , a Chuck style rotary. Being how | am, | could not leave well enough alone
and had to improve on it, so | opted for the more consistent and reliable 4 Jaw chuck that has
not been made for laser machines. This rotary is currently in R&D and projected to be out in the
fourth quarter of 2023 if all goes to plan.

That pretty much covers how Rotoboss got started and how we ended up here today.
Again, | want to thank you for your support.

Your feedback Is paramount to me and the growth and quality of our products. | would love to
hear any feedback from the maker community to help Improve our product line so we can better
help you optimize your business success.

Please send your feedback to rotoboss@rotaryattachments.com
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—*DISCLAMMER®

JER Custom Designs Inc. and Affiliates are not liable for damage to equipment or bodily injury due
to improper use of these Rotaries. Careful thought and design have gone into these products to
limit the potential for obstruction which could lead to damage to you or your machine. Make sure
to always check your clearances to ensure there is no danger of impact prior to operating these
rotaries. Due to the nature of the manufacturing process, Rotaries may have some sharp edges

that could cause injury. Take a moment to familiarize yourself with the rotary and take note of such

areas. Every effort is made to mitigate the risk to the end user.
*Not recommended for anyone under the age of 16.*

**https://rotaryattachments.com/product-category/rotoboss-swag/
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VIDEO GLOSSARY (PG #¢%

*Right Click to open link if it does not open normally, or copy and paste into browser* -

https://www.instagram.com/rotobossrotaries, @ https://www.youtube.com/channel/UCzrLYdbjylXjJM91ulclQhQ @ https://www.tiktok.com/@rotoboss

Rotoboss https://www.facebook.com/groups/559200807984810
Tools/Jigs: Boss/Aeon https://www.facebook.com/groups/540298903199333

ﬁ' https://www.facebook.com/Rotobossrotaries ~ Facebook Groups:

Youtube Playlists

»>Talon
https://www.yvoutube.com/playlist?list=PLYkJ L4UZaCyOv6acETyxNuwYepShpRBq

»>Trouble Shooting
https://www.youtube.com/playlist?list=PLYkJ L4UZaCyCCGhyxOpelcIClhlx OXH

»Rotary setup and software set up
https://www.youtube.com/playlist?list=PLYkJ L4UZaCz5Dles-j1VAoMUpKNBuUBK6

Other Youtube Playlists

»Ascend
https://www.youtube.com/playlist?list=PLYkJ L4UZaCyj6c_5PhIfOuxp9uyavGGs
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https://www.youtube.com/playlist?list=PLYkJ_L4UZaCyj6c_5PhlfOuxp9uyavGGs

VIDEO GLOSSARY (PG.2) *ﬁ“"""*.

"' lnl“’
*Right Click to open link if it does not open normally, or copy and paste into browser* = ww

g!jTAé; A ACHMESTS

Other Videos to check out:
»RotoBoss and RotoBoss Junior Setup and install for Thunder NOVA 24-63:
https://youtu.be/ehcZFILSWkk
»>AutoBoss (for RotoBoss Rotary) in Action:
https://youtu.be/QJTMal-YBI8
»>Spring Loaded heel Wheels Install/Use
https://www.youtube.com/watch?v=CyDulr_E-PM&t=91s

»>Video explaining the differences between the RotoBoss models:
https://www.youtube.com/watch?v=KnjNhZg064k&t=2s
»Low Roller Placement & Setup Video for Thunder NOVA 24.
https://youtu.be/Z3470e2bhKU
»Side Support Bracket (Low Roller)
https://youtu.be/Z3470e2bhKU
»RotoBoss and RotoBoss Junior Quick Slave Wheel Adjustments:
https://youtu.be/FZsgaixgSsM
»>ALL METAL UPGRADE KITS Install Video:
https://www.youtube.com/watch?v=3RAAg0gFZulU&t=631s
»Rotoboss Rotary Attachments Accessories Video:
https://youtu.be/P7Gb_nHm8eM

20


https://youtu.be/ehcZF9LSWkk 
https://youtu.be/QJTMaI-Y6l8
https://www.youtube.com/watch?v=CyDu1r_E-PM&t=91s
https://www.youtube.com/@rotobossrotaryattachments
https://www.youtube.com/watch?v=KnjNhZg064k&t=2s 
https://youtu.be/P7Gb_nHm8eM 
https://youtu.be/Z347Oe2bhKU 
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https://youtu.be/FZsqaixqSsM 
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